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SHAUN BRYANT: Can you all hear me OK? Good. I'm not shouting. I've escaped from the party and went and

jammed with my band in [INAUDIBLE] outside of Vegas. So my voice ain't so good this

morning. Ended up doing things like, A Whole Lot Of  Love by Zepplin and things so it all got a

bit loud. My voice is telling me about that this morning.

AUDIENCE: What's your band's name?

SHAUN BRYANT: We don't actually have a name, weirdly enough. It's just a bunch of musical CAD people. We

always get together every AU. And you'll see on the next slide why I have a musical slant. But

there's a bunch of us that-- I mean, I sing and I song write. Got a couple of guys that play

guitar. Couple of people from [INAUDIBLE]. One guy plays bass, one guy plays drums.

And we just rent a space. It's called MDV Entertainment, and it's literally just a box on an

industrial complex outside of the city. I did about an hour at the party. Enjoyed the band at the

party, actually. What were they called? The Spasmatics or something? They were quite good

fun. Playing lots of stuff that I used to dance to [AUDIO OUT] But yeah, I escaped, and went

and had some more fun. OK. See if we've got any extras, and then we'll get going.

How does that sound for you? Is that all right? Yeah? OK. Good morning guys. Welcome. On

UK time, it is 6:30 in the evening. So I'm still working that one out. OK, I'm Shaun.

As you can see, I've been running my own business now for, let me think, 16 years. So I'm the

owner and lead consultant of CADFMconsultants. Primarily providing facilities management

consultancy, but also provide a lot of what I call platform technology consultancy around

AutoCAD. I've been working with AutoCAD 28 years now for my sins. So that probably gives

away my age, if I say I started on AutoCAD release 10 for DOS. For those of you that actually

know what DOS is.

No, seriously, I did a class at an ATC in the UK recently, and they were all under 20. And I

mentioned DOS, and it was like, huh? Had to explain to them how Bill Gates became Bill

Gates, and it all just went completely off on a tangent for a while. I have my blog, Not Just

CAD! You can find that, it's on Twitter as well and so on. Haven't blogged as prolifically as I

should have. I've had a few personal things to deal with recently, bereavements and things. So

just, things have to kind of take a back seat sometimes.



I've written for AUGIWorld, Cadalyst, Redshift. You all aware of what redshift is? Redshift is

what used to be lineshapespace.com. It's an Autodesk website. But it's a blog site with lots of

articles for small-medium enterprises, and I'm a small-medium enterprise. So I quite often

contribute there.

My main line of work actually at the moment is, I'm a content or for LinkedIn Learning. Which

used to be Lynda.com. Lynda.com got purchased by LinkedIn about 18 months ago. AutoCAD

and Revit consultant and trainer. Certified professional in both, as well. And funnily enough,

also a singer/songwriter. And I released my first album June 2012 on iTunes and Spotify and

everything else. And we're working on the second one at the moment. Again, it's one of those

things that I kind of fit in when I'm not working. So unless someone like Universe will come

along and give me half a million to get the album finished, and then I might actually make it a

priority. But I can't see that happening some time this century.

So that's me. You know I'm standing there looking a bit wistful and pretty with my Hofner

acoustic. I managed to get a guitar endorsement which is quite nice. They asked for some

promo shots to be done, so that's Leadenhall Market in London. One of the oldest market

squares in London, right in the center near the Royal Bank-- near the Bank of England.

So I'm not going to read the Class Summary to you. I'll let you read that on the app. I am not

going to do Death by PowerPoint and read every word there. Basically what we're going-- it's

in essence plotting and publishing one [INAUDIBLE]. And I'm going to show you some little tips

and tricks on how to make it work, how to make it happen, using all the tools.

Now it does actually say AutoCAD 2016 software, and I am running 2017 on my laptop now.

There's no difference. Seriously, there is no difference at all to the dialog boxes or anything

like that. And basically at the end of the class, you'll learn about printing and plotting. And the

fact that they are no different. It's just a word.

Basically what you're doing is you are outputting your design and your content and so on. We'll

also learn about working in model space and paper space. How many of you plot from model

space, just out of curiosity? There will be some of you. It's OK, you can admit it. It's fine. It's

not a problem.

And how many of you plot from paper space? Yes. So basically, the standard method is do all

your design in model space, scale view ports in the layout tabs in the paper space, and so on.

What we'll also look at is page set ups, all the little tweaks and tricks that you can work with



page set ups, and the Page Setup Manager. And we'll look at plotting, electronically obviously,

to things like DWF, the good old dwif. And the DWFx, and also PDF.

Just as a-- this is purely out of curiosity for me, how many of you plot to DWF into the PDF?

And then how many of you plot to PDF? Boom. Yeah, there you go. It's funny actually, of

what's in lots of different companies. And PDF is the norm. And yet DWF is a lot more

sophisticated, and has a lot more technical use to it. And it's a great file format, and it's very

underrated. So hopefully at the end of this, you'll kind of understand some of the little tools on

why DWF can be used well.

So, introduction to plotting and publishing. Let's have a little look at printing and plotting and

scaling, more importantly. So I'm going to jump back into one of my AutoCAD drawings here.

And for some weird reason by the way, my AutoCAD window keeps coming in small. Don't

know why. So, apologies for that. It should just jump in like that straight away.

So I'm going to jump straight into the output tab here. And that's the main tab we're concerned

with during this particular class. But what I want to talk about is the scaling. So, it's just a

standard floor lay out there of a building. You've got your dimensions, your grid lines, standard

sort of what I call architectural type drawing. There's nothing special there.

And just so you know, this class follows along with my LinkedIn Learning course on LinkedIn

Learning as well. So the content you've got here, if you want to go and learn more and in more

detail, it's actually online as well. And I do have a 30 day trial, so you can spend 30 days on

LinkedIn Learning for nothing. So you can go and learn even more stuff as well.

So I'm going to jump into the model here, like so. And I'm just going to zoom out. And you can

see here, yep, that's definitely not feet and inches. It's millimeters, guys, OK, sorry. Apologies

for that, but hey. I come from a metric country. I can't help it. I can't help it.

So you've got the dimensions on there, and obviously the dimensions give you the context of

the drawing. And you realize that there's no way that sort of like 1,830 feet for a doorway, for

example, yeah? So, the idea being, is it's just a drawing. It's just a regular box standard

AutoCAD drawing. But how do you fit a distance of 1.83 meters onto a sheet this big?

Well, the simple solution is, you use your scaled viewports. Now, it may be that somebody

might want a title block around that in the model space, and plot it to scale instead. So within

the model here, within the model tab, we can go into Plot or Page Setup Manager, and just do



a one off plot like so. I can go in there, usual way of plotting. Standard dialog box, you select

the output you want to go to. It's quite scary how many outputs you have now, actually, as

well.

I mean, I can just set it to A4 and send it to a fax on my HP printer at home, if I wanted to. But

there's all these little different settings and things. But more importantly, there's all these

different ways of plotting. And I'm not going to try and force any particular method on you,

because the idea being is, I'm sure all of you work for different companies, or for yourselves,

and have different ways of doing things. And the standard way, as I said, do everything in

model, scale viewports, obviously, in the Layout tab.

So this drawing is set up to use that traditional method. So everything here is full size. So if I

zoom in there, you can see that that particular restroom there is 2 and 1/2 meters wide, and

so on and so forth. So if I come into my GA tab now, my layouts tab, you can see that we have

a nice pretty blue viewport there. And if I click on that viewport, it tells me that it's at a scale of

1 to 100 just there, down on the status bar. That's how you print-- traditional-- print, plot,

whichever word you want to use. It doesn't matter anymore.

Are you all aware of why the differentiation between those two words? Printing and plotting.

Because I come from a background where we had to screw all the little rotating pens into the

plotter head. Hit the button, 45 minutes later you got one drawing. And if you had forgotten to

fill one of the ink reservoirs, you had another 45 minutes to wait. But now it's literally hit the

button, done. And literally within seconds you have a plot.

Now, what I'll do here though, is just quickly jump into the GA tab. And if I go to plot, the nice

thing about AutoCAD is you can preview stuff. So there's my preview, and it's all set nice,

monochrome, ready to go. And I can now just right click and I can hit the Block button. If I want

to. I'm not going to. Not going to bore you with that little bubble at the bottom right hand corner

where it plots.

But I'll just exit that, and it takes me back into the dialogue box again. So that's the standard

traditional method of plotting. Now what I want to take you through is just some of the little

variances on that. Some of the little sort of tweaks that you can do. Now how many of you use

the Publish dialogue box? There's a few of you. That's good.

Now, the publishing dollar box saves a huge amount of time. If you've got 15 layout tabs, you

can plot them all at once. And the best bit about that, there's a little tick box where you can plot



them in the background. So they all crank out slowly in the background, and then a little

bubble comes up and says, hey, we're done. So this tool's in there, so let me just jump into the

Death by PowerPoint again.

That's basically printing and plotting and scaling. So what I'm going to go through now is the

model tab, the layout tab. And I'm going to start-- the drawings are already there. I'm not going

to start from scratch and draw an entire layout for you and then draw that the dimensions,

details, and everything else. We look at the model tab and the layout tab, and setting our

limits.

How many of you use the limits command? There's a few of you. How many of you know that

model space is infinite? That it goes on forever, and ever, and ever? Yeah? How many

drawings have you had into your office where there's something down there, and then there's

something over there near Mars? Yeah? When you do a Zoom All or a Zoom Extent. Yeah?

That's what setting your limits is all about. And trust me, it-- When you do Zoom All, it zooms to

the extent of those limits. So you have a finite space in an infinite space, that just makes your

life that little bit easier. So we'll look at that. And we'll look at working with model space and

paper space a little bit first.

So I'll just jump back into my drawing here. Now obviously you set your limits in the model.

Like so. So there's my plan. And the nice thing is, is I can do a thing called an ID point. All

aware of the ID command? Just type ID, Enter, and it asks you to specify a point. So if I go

over here to an end point snap on a grid or something, I can click there, and it gives me the

coordinates of that. So, roughly speaking, x is about 9,200. y is about 4,000 ish. So I know that

that corner there is roughly 9,000 comma 4,000 when you look at x and y coordinates.

So what I'll do there is, I'll type the word, limits, and press Enter. It's that quick and easy. And it

asks me for a lower left corner. Now the lovely thing about this is, I don't physically have to

type in a value. I can literally just click there, and then it asks me for the upper right corner,

which at the moment is trying to go to 12,9, because I haven't actually set my limits in this

drawing yet.

So if I take this up here, how do I check where the coordinates are, roughly speaking, up

there? Well I come down here, click on the little three bars there, and right at the top of that list

I've got coordinates. Switch it on, hit the three bars again, and there's my coordinate read out

there on the status bar. So if I come up here now, it's giving me roughly-- what's that? I don't



there on the status bar. So if I come up here now, it's giving me roughly-- what's that? I don't

know, about 60,000 by 32,000. So my upper right corner, 60,000 comma 32,000. Because I'm

in millimeters, so there's lots of thousands.

So if I do that now, I've set those limits. So those limits now, if I do a Zoom All, over here on

the Navbar-- can you see? It zooms me to that space I've set in the infinite model space. And

it just gives you that little bit of control. Because you'll always get that drawing where there's

something there, and there's something near Mars. It's going to happen. But the idea being, is

you fix that drawing by making sure that those two objects are brought together, and then you

set the limits so that every time you do Zoom All, you're in the right space.

Now if I did a Zoom Extents, I'll just double click on the wheel there, it's pretty close to Zoom

Extents. But Extent zooms to the extent of the visible drawn objects in the drawing. So

everything that's on a layer that is either on, or thought out, it will zoom to the extent of those.

So Zoom Extents doesn't help you in the infinite space, so to speak. It does help you if you do

this, where you zoom in really, really, really, really close like that, and then you think, where

the hell am I? Just double click on wheel, Zoom Extents brings you back that way.

But, also now, you've got the ability with the Zoom All-- he says clicking on the wrong button--

do a Zoom All there, and that zooms you. But more importantly, if you set those limits, you

might be working to a prescribed grid. So in the UK, we have Ordnance Survey. Ordnance

Survey [AUDIO OUT] a grid of what they call north things and east things on a map. We can

specify those physical coordinates in the same way that we specify those limits.

So it may be that we've got a fixed place where this building is, and we need to put the

Ordnance Survey gridding instead. Instead of just what I call a temporary grid. So once you've

got all of those limits set up, we then need to start looking at working within the model space

and the paper space. Now we obviously know that this is all in millimeters, and I'm working in

millimeters because I'm English. Again, sorry.

And-- actually. no, why should I apologize? You stole feet and inches from us. And then we

went metric, and you decided to keep it. That's the way it works. I'm not even going to mention

Donald Trump either, because I will get into so much trouble. So, we've got our millimeters all

set up there in the model space. Our limits are all set up. We're ready to go now and start

thinking about scaling.

Now, when we're working with the model space and the paper space, if I go into the GA that I



mentioned, that's all nicely set out at 1:100. And I've got a staircase, A, which is another

viewport here. Just looking at that particular staircase, and it's the top left stair case here in the

model. It's this one, here. Now you'll notice, I've got one single dimension that looks a bit

different there. Yeah, can you see that? I've got to dim there, and I've got to dim there like

that. Now, why are they different sizes? Can anybody tell me? You get a LinkedIn pen if you

tell me.

AUDIENCE: [INAUDIBLE]

SHAUN BRYANT: That's just [GIBBERISH]. Louder.

AUDIENCE: Annotation.

SHAUN BRYANT: Somebody said annotation. Would you like a pen?

AUDIENCE: Sure.

SHAUN BRYANT: Now you stay there. You've got something on your leg, that's fine. You're welcome. Now,

yeah, annotation. Now annotation and annotation scaling we will cover in a little while. But the

idea being, is that annotation has to be communicated effectively with the right scales. Now I

know all of you have set up a viewport, and the scale of your dimension has been so tiny that it

just looks like a little line. I've done it as well. Annotative scaling allows you to avoid that. So

when I go into stair A, here, you can see that dim is consistent.

If I go to GA, funnily enough they all look the same size. Regardless of scale in the viewports.

And that's all to do with your annotation scale, and annotative scaling. Which we will cover it in

a little while. What I'm going to do is, I'm just going to move my viewport Over.

Just drop that into that corner there like that. So there you go. And I'm going to create a new

viewport, so usual thing. Home tab, layers here, so I'm going to quickly show you all the layers

I've got in the drawings. There's all my layers there. Drop down, and there's my viewports

there, so I'll just make that current.

Now obviously, when you're plotting, there is a little rule with viewports. What do you do with

viewports in the Layout Properties Manager?

AUDIENCE: Turn them off, [INAUDIBLE].

SHAUN BRYANT: No, don't turn them off. Don't freeze them.



AUDIENCE: [INAUDIBLE].

SHAUN BRYANT: That's the one. Don't not plot. So that's-- funnily enough, right over here for me. It's that little

one there. So always set your viewports not to plot. Otherwise you end up with lots of pretty

boxes all over your layout tab when you plot it. So just make sure it's set not to plot. Always do

that little sanity check.

So that's my viewports there. What happens now with the later versions of AutoCAD is, when

you're in your-- this, from a training perspective, this is just so damn confusing for a trainer.

Because you've got your Layout Tab's bottom left. You've also got your Layout Tab on the

ribbon. So when I'm training in a classroom, it's click on your Layout tab. And they go, huh?

Because there's two. There's that Layout there, and there's that lay-- well, there those Layouts

down there.

So just be aware that they've got the same name. And when you are talking to somebody in

the office and you tell them to click on your Layout tab, just make sure you obviously tell them

which one, left or right. So in the Layout tab here, I can now jump in and create what is called

a Layout viewport. So I'm going to pick a rectangular one, just to save time. So that's a click,

and a drag, and a click. So there's my viewport there.

Now, what you'll find is, as soon as you create a new viewport in AutoCAD, it automatically

defaults to a Zoom Extents view in that viewport. So I've no clue what scale that viewport is. I

need to double click inside it. And this is the scaling thing I was talking about. So I'm now a

scale of 0.0044730. Possibly an unrecognized scale, maybe. However, what I can do is, I can

zoom in and out, and pan, and so on.

But the problem I've got is, my dimensions now. Because it's an unrecognized scale, my

dimensions aren't consistent. So I'm going to zoom in on, let's say, this rest room here. I'm not

going to worry too much about switching layers on and off in the viewport as such. I'm going to

get it to there like that. And then you'll notice I'm now 0.03. So I could probably get away with

something like 1:30 there maybe. Let's try that. That's pretty close.

So it's now a recognized scale. But you'll notice those dimensions are way, way, too big. Way

too big indeed. So I'm going to leave that viewport as it is, double clicking outside the viewport

to deactivate it and go back to my model tab. So these dims here, you'll notice, are not

annotative. So they're just plotting, scaled to whatever size they are in the model space. If I



want that to be an annotative dimension, I have to change the dim style. So I'm going to jump

into Properties. If I click down here, he says, OK, I can just about see the names of them here.

I'm going to find the anno one. There we go. There's my annotative one, and I'm going to give

that an annotative scale now of 1:20. Just to confuse the issue. But you'll notice-- can you see,

as soon as I do that, it changes size. Now, if I go back now to that stair A, can you see that dim

has disappeared? Can anybody tell me why?

AUDIENCE: [INAUDIBLE]

SHAUN BRYANT: Pardon me?

AUDIENCE: [INAUDIBLE]

SHAUN BRYANT: Yes. Because the annotative scale there, doesn't match the viewport scale. That's exactly

what's going on there. So what I need to do is, I need to make sure, back here in the model,

that I select this. And what I do is, Annotative Object Scale, Add Delete Scales. Again, my

dialog boxes are doing some very weird things on this projector. So if I go in there, there's my

1:30. I'll OK that and add it. 1:20 I don't need any more, so I'll delete it. And I'll OK that.

Slightly different size, but when I jumped back here into stair A, can you see that? It's now

consistent with that. So that's the scaling thing that I'm talking about. So as long as your

annotative scale, in your model, on that dimension is 1:30, and as long as your viewport scale

remains at 1:30, it works. And you make your-- you would make your dimension style

annotative.

So if I jump into the Home tab, Annotation flyout, and come in here. You can see-- I'm not sure

if you can see that. Can you see there's a little symbol there, next to that style? That's telling

you that its an annotative dimension style. And the way that you set that up, if I jump into

Modify, is if I go into Fit here, its Annotative there. Just a tick box.

So that's setting your limits, and working with your model space and paper space. Now, we've

kind of leapt ahead a little bit there, with the annotative scaling. So what we need to think

about-- I'm going to jump back a step-- is when you're setting up all of your plotting, how many

of you use Page Setup? Or do you just Plot Preview and Plot? See not many of you

[INAUDIBLE] page setups.

Page setups are a wonderful, wonderful time saver. Huge time saver in fact. And you can set

them up in the Model tab. You can set them up in the Layout tab. Modify them, and if you've



got other drawings with ones that you want to use, you can import them across as well. And

they're a really, really useful little tool. So let's just have a little look at those.

So I go to the Model tab, and I right click on the Model tab, and I go, Page Setup Manager.

Good thing is, it's a nice big dialogue box that I hope you guys will be able to read. There we

go. Let's make that nice and big. Now, it's very simple.

At the moment, in the Model tab, I don't have any page setups. There are none at all. Because

if I look at this-- I now feel really short. Can you see where it says model, with the asterisks?

That's telling you the layout.

So the default for the layout, in this case the Model tab-- and I'm not using it is a Layout tab,

by the way. I'm saying the layout of the Model tab. The Device Name is none, Plot It is none,

and it's plotting to a 210 by 297 millimeter sheet. Which is an A4 sheet in UK measurements.

So if I wanted to set my up to plot to a particular thing, what I could do there is, click on New,

and give say an A4-PDF, like so.

And I could OK that. And I can set that to plot to PDF like so. And there's the A4 there. I'll

center the plot as well. And as you can see, it's jumped over to one side.

I'll set that to monochrome, and assign that to those. And I'll OK that. And there it is there.

Double click it, and that now applies to anything I plot out with that particular Model tab. And

that's how I just set up a simple page set up like that.

And I can use that over and over again. Now, I can do that in the GA, as well. If I right click

here, Page Setup Manager, I've already got some set up. Now, you'll just have to excuse me

one second. I'm going to have to go to the bathroom. I won't be a moment. I do apologize

profusely.

All good? That's better. And I've got an A1 sheet size there. And I've got an A4 Scale to Fit

there. So, as you can see, the stair A is using the A1 landscape. And the GA is also using in

the A1 landscape. So when you select one of these, and you double click-- so if I selected A4,

watch the GA here at the top of the list. If I double click, it adopts a different page setup. So it's

now plotting to a much smaller sheet, an A4 Scale to Fit.

What I've done with each of these is the A4 Scale to Fit is a much smaller sheet. And it's

literally just fitting the sheet. So you can completely ignore the scale on the drawing. So how



many of you plot like that sometimes, to a smaller sheet and ignore the scale? And you might

put it on a clipboard, or put it in your portfolio to take with you on site, or whatever. You can do

that, and set it up so that all these different page setups are in place.

Now one of the benefits that this allows you to do, if you're a CAD manager and you've got two

or three different plotters around the building, different areas where people work with CAD.

These page setups allow you to plot to different devices as well. Not just sheet size. So the

reason I set those up, is I've got an A1 plotter. And I've also got an A4 printer that somebody

might use. So an engineer that's going out on site all the time, he'd be sitting next to the A4,

plot an A4 out of a part of the drawing that he needs to take with him. And off he goes.

Now I'm talking about this is if we use paper all the time. How many of you use paper? Still a

few of you. Still a few of you. It's quite funny. I'll give you a slightly anecdotal story.

I went to a conference about six years ago now. And it might have been a bit longer, actually.

It's when Carol Bartz was still the chief exec at AutoDesk. And the actual conference was

sponsored by HP. And Carol Bartz basically stood up on stage and said, we're now in a

paperless industry environment. You can imagine all the guys at HP going, hmm. OK. Just

paid for the conference and you're telling us not to use our products. Anyway, it's just one of

those funny little moments where three or four of us just looks at each other and went, should

she really have said that?

But we are moving to that environment. We are moving to that environment. So for example,

my A1 landscape, if I go in to modify that, it's actually going to a DWF. But I can use or

something like design review, or perhaps, anything else maybe. So the idea being, is I can set

up any sheet, any device, any size, any plot style as well. Do any of you guys create your own

plot styles? Do you use CTB or STB?

[INTERPOSING VOICES].

SHAUN BRYANT: Yeah. So, again, there's a variance there as well. Because you've got color dependant plot

styles, and you've got named plot styles. Which we will cover in a little while. So the whole idea

is, is this Page Setup Manager allows you to go in and basically set things up to work for you.

So use those page setups. They're very quick and easy to use.

So you can see that I've left that at the A4. So I can come back there, Page Setup Manager,

and go OK. I want to change that. So I select A1 landscape, double click on it. The A1



landscape page set up now applies to the GA tab. And I close that out. It's set up like so.

Now that particular title block is actually drawn in-- well, it's not drawn in the Layout tab. I

correct it in the Model tab and then copy it across. But it's set up for an A1 sheet. Which is 841

millimeters by 594 millimeters. So, about so big, like that. Whereas the other one, the A4, is

about that. So the whole idea is that you're scaling something to fit onto a different sheet size,

and perhaps plot on a different device.

So that's why those page setups are there. Now last but not least, importing a page setup. So

if I've got two or three different drawings open at any one time, I can import a page setup from

one drawing to another. Now sometimes, your page setup might not be the same as a third

party's page setup that is sending you drawings. So you can import their page setup into your

settings, into your Page Setup Manager as well.

And it's very quick and easy to do. I've got a couple of drawings opening. So I've got a CTB

file, and an STB file there. So I'll just quickly jump into the Page Setup Manager, and I want to

import one. So I import like so. I'm going to jump in here. As usual it's gone back to my root

folder, but don't worry. We'll soon find those. There we are.

So there's my class there. So if I pick, say, the CTB drawing like that, and I Open, there's the

page setups there in that drawing. And strangely enough, they're named the same because I

did copy the drawing. But you get the idea there. So I'm looking in the CTB drawing now, for a

page set up that I might need to use.

Nice thing is, if I click on one, it tells me what the settings are before I import it. So I know it's

the right one. And I know that the parameters in that page set up are the ones that I want. So I

can jump in there and bring things in ad nauseum. However much I want to.

Now, viewports. Do we all love viewports? More importantly, did you know that you can set up

viewports in your Model tab? Question. Can you plot from the viewports in the Model tab? I

love this one.

Simple answer is, yes. Of course you can. Because you can plot for model, no problem at all.

However, the viewports in the Model tab are different views on the elements you have in the

Model tab. So you can be in a particular viewport in the Model tab and say, I want to plot this.

And then you can start utilizing your page setups again.

Because you might have your particular model space set up into four equal viewports. And you



might have a page set up for each particular viewport, because it's a different view on the

model. So let's have a little look at the viewports in the model, and the viewports in the layout.

And we'll also do a little bit of polygonal viewports and clipping viewports and things as well,

which is quite good fun.

So I'll jump back into that main 01 plotting and publishing drawing again. And what I'm going to

do, I'm going to create a new layout. In fact, no, what I'll do, I'll do a move and a copy. Much

easier. So I'll copy the stair A one there, I'll move it to the end. And I'll create a copy.

Now, are you all aware of how to do that? Yeah? Moving or copying layout tabs is so easy

now. Really, really easy. In the old days, it was really hard to do this, because we didn't have

tabs. We only had tile mode 1 or 0. Luckily, AutoDesk thought about that one, and it's a lot

easier to do now.

So I'll OK that, and I've generated a new Layout tab there. Which is an exact copy of that one

there. So there's my Stair A 2. So I'll go in there and you can see that I've got viewports there.

And I've also got the Model tab there where I can create viewports as well.

So I'm going to put some new reports in that Stair A 2 in a moment. Let's look at the viewports

in the model first. Now, if I want to set up viewports in there, I go to the View tab on the ribbon.

And you'll see that you have Model Viewports, like so. So if I click there, I can have all these

different configurations of viewports.

Now be aware, if you want any named views in a drawing, this came up in the certification

exam last year. This is quite a good one. If you ever want to change your named views now,

you have to go up here, to the View Manager. See where it says Top, and View Manager.

That's where you can create all your different views and preset views.

So you can see here, I've got some preset views. If I go to something like the Entrance, Set

Current and Apply, and OK that. Takes me to somewhere completely different because I

moved everything, remember, with the limits. So it's like, oh, OK. It won't find it anymore. But

what I can do there, is I can create different views in the View Manager there. And be aware,

that's probably the quickest way to get to the View Manager.

So if you're doing any certification or anything, there's always a question on something like

this. So check your View Manager like that, and that's how you can set up the views there. And

you've obviously got your preset views, like Top View. So if I set that as current, Apply, and



OK, that takes me back to the top view there like that. So that's named views.

Viewports are something slightly different. So if I go in there and I want four equal viewports, it

splits the screen. Now these viewports-- of course you can plot from them. There's nothing to

stop you plotting from any of these viewports. But you can set up a Page Setup for each one.

So if I go to-- let's say I go into my top left viewport, like that. And then what I can do here now

is, I can right click, Page Setup Manager, create a new one there, and call it top left. And I'll

use the A4 PDF settings for now. Leave all of that as is, and OK it. And then what I'll do is, I'll

Apply that now to my model. And it's using the top left page setup settings.

Because you might have a different view in each viewport that needs different settings. So

that's my top left in there like that. So if I close that now, and perhaps zoom in, and let's say

I'm looking at those columns there. So if I now right click and go to Plot, it's using my top left,

what to display there, so it's DWG to PDF, also A4. I'll un-center the plot there, maybe. Or

center again, it's entirely up to whichever way I want to set it up.

I might want to do Window. So I'll pick a window where I'm going to plot, like that. And that's

now my top left settings. Or is it? Because I've changed the settings now. It's not showing me

a page setup anymore. So if I go there and go top left, and then preview that, it's all set up.

Ready to go to that PDF, for that particular viewport in the model.

So your viewports in the model are a method of viewing particular views of the model in the

model space. However, you can plot to them as a viewport, like that, but in a slightly different

way to the Layout tabs. If you've got a really, really big model in model space, that's a really

nice way of getting around and plotting stuff out. Because it just means that you've got a

setting for each viewport, depending on your viewport settings in the model tab.

So I'll just cancel this. And if I go back to Viewport Configuration there, go back to a single one,

it'll always go back to the current viewport, which is that top left. So when I click on single, I'm

zoomed in on those columns at the top there. All OK with that? Does that help anybody, more

to the point?

Does that mean that you can now utilize that a little bit in your working environment, so that

you can then have four different viewports of the same model, but have differing views in each

one? So I'm zoomed in on the columns there, but if I set that back to you four equal, I've now

got four equal views of the columns. And so on it goes. OK?



Now, I'm sure most of you just prefer to have that, because you've all got massive great big 27

inch screens back at base, haven't you? Unlike me, with my MacBook screen. My little 15.1

inch MacBook screen. Or better still, you might actually own one of those nice Microsoft

Surface Studios that are out in the exhibition hall right now.

I got a quote for one of those yesterday, and I really wished I hadn't. They're about $4,000 a

go at the moment. So I won't be rushing to buy one soon. But hey, they are lovely things to

look at. They are a thing of beauty.

Polygonal viewports, clipping viewports, and making viewports from objects. Do we all use

these? Yeah, got a few of you. So I'm going to jump back into AutoCAD again. Now what I'm

going to do, I'm going to jump into my Stair A 2, here. Now, you'll notice something weird's

kind of happened. What's going on there?

If go to Stair A and Stair A 2, there's something very strange going on. Let me just jump back

into my layers here for a moment. And what we need to check is, ooh, there's some layers

being turned off. If ever you get anything like that happen, which I have, they are-- I've

deliberately turned these off. So, Title Block, Title Text, they come back. Viewports, switch

those on as well as well so I can see. And obviously my text is kind of important as well.

So if I bring that back there, everything is back again. So if you get something like that happen,

it's just a sanity check on the layers. Always check your layers. Make sure you can see what

you need to see. So if I go back to Stair and A 2 like that.

Now, I've got that viewport that we set up earlier back here, because I did a copy, remember?

So there's Stair A and Stair A 2. So I'm just going to lose that one there. Just going to delete

that. Now, what I've got here, you'll notice, is I've got got a viewport-- if I just zoom out slow,

but that viewport there. Now obviously, you can click on it, click on the grips, perhaps make it a

bit smaller like that.

Which leaves me with a weird and wonderful space here. I've got like an upside down L shape.

Now the lovely thing is, is if I just jump back into my viewports layer, and go to my Layout tab,

I've got the option here of creating a polygonal viewport. Now, that means that I can specify

the start point and the end point of the viewport. So if I use my Object Snaps, and just come

around like this-- just following the title block around-- and then Enter, I've now got a really

weird shaped viewport, which doesn't help my plan B whatsoever.



But, the benefit I have is, I can double click in here, and perhaps bring that down like that. And

I might have some-- I might have a table up here, perhaps. A room schedule or something like

that in the model space as well. And obviously that's-- in this particular instance, is not a

perfect environment for that drawing. But think about it. If you've got an L-shaped building, if I

wanted to have an L-shaped building in its own viewport, I've got an L-shaped viewport.

If I've got hexagonal building, I can have a hexagonal viewport, if I need one. So the idea

being is, the polygonal viewport setting allows me to obviously generate different shaped

viewports apart from the bog standard rectangular viewport. And again, just double click

outside to de-activate. I could set a scale for that if I wanted to as well. So I'm just going to

remove that now.

And what I'm going to do now is, I'm going to clip a viewport. Now, clipping a viewport, really,

really easy to do. I'm just going to literally pop a rectangle, say from there to there. Now that's

not a viewport, I hasten to add. That's a rectangle drawn on the Viewports layer. So I jump

back into the Layout tab, and I can clip here. So I can clip a layer of viewport object, and

reshape the viewport border.

So if I click on Clip, it says select the viewport to clip. So there's the viewport. And select the

clipping object, which is there. And it clips it to suit. This is very, very useful, because it means

that you can have a viewport that might be already on your drawing. And you think, mmmm,

not happy with that. Doesn't look quite the way I want it to. You can then draw an object and

clip it to suit.

And that gives me a much cleaner viewport. And then what I can do, if I need to move that,

again just use the Move command, Object Snap, Object Snap. And that's a much better

utilization of space, because I can guarantee you'll always find that with your viewports on your

layouts, in your sheets like that, that you run out of space. You want to put so much on a

drawing-- my suggestion there is, is if you do run out of space, create another layout tab.

There's nothing to stop you doing that, because everything is in the model space. You just got

a create another scaled viewport.

So, do it that way, rather than try and squish everything onto one particular Layout tab. You

can have-- well, the layouts are limitless, but I wouldn't try it. You'd probably crash your

machine quite well with about 250 Layout tabs. But, I mean the most I've had on corporate

and industrial drawings, is somewhere around 15, 20 maybe. But a lot of those are quite small



ones, like little details of structural steel work, for example. You know, door openings, that kind

of thing. So, it depends. Depends on how you're setting up your project.

So, viewport scale and annotation scale. Let's review what we've done. We've looked at the

viewport scale. We set it to 20 and 30, didn't we? And the annotation scale, we tweaked, with

our annotative dimension style. So the annotative scaling allows you to have everything

consistent in those viewports. So as long as your dimensions, your text, you can also apply it

to hatching-- as long as I've got that annotative scale, of say 1:30 they will all appear nice and

neatly in that 1:30 viewport in the Layout tab.

Make sure that you check that one. It's one of those ones where, you just go and check the

properties. Like I did. You saw me change it from the 1:20 to the 1:30 in that viewport. It's just

a case of adding another annotative scale, or sometimes deleting an annotative scale as well.

Now, any of you use the Quick View, in the Drawing tabs much? I quite like them, they're-- I

mean, a lot of the content that I do for LinkedIn, Lynda.com. This allows me to kind of jump

between drawings. And it allows me to have multiple drawing set up when I'm creating the

video content. So your drawing tabs are up here. And you can see that I've got various

drawings open.

And the nice thing I love about this is, I can hover over that tab, and it gives me all of the

Model tab, and the layouts. So I can now go here, to that Model tab, in that drawing. I can now

go here, to Stair A, in that drawing. And I can now go here, to GA, in that drawing. So if you've

got a number of multiple drawings open, it's just literally hover, click, hover, click. It's a really,

really nice tool to use.

Now, I can remember having to use alt-tab all the time to jump around between drawings,

when I was working with older versions of AutoCAD. This way I can see which drawings I've

got open. But also more importantly, I don't know if you can see that. Can you see there's a

little asterisk on the tabs? That little asterisk is telling you that that drawing hasn't been saved

yet. And it's a great little sanity check just to say, oh, you've made a change but you haven't

saved it yet.

So if I went to, let's say the plotting and publishing one here, I went to the model, clicked on

Save, you see that little asterisk disappears. It's actually that one there. So if I hover over that

one, becomes that drawing there. Click on Save. Can you see the asterisk is disappearing on

each one as I save it?



And it just-- it's just one of those little memory aids that you look at it and you go, oh, haven't

saved it yet, just before you walk out the door. Kind of like that. So that's a nice little tool. And

what's even better still, is if I hover over these and then hover over that, I can plot. So I can

plot that particular GA just by hitting that button there. There's the GA. There's the Page

Setup, and off we go. I can preview that plot.

And you'll notice that, hmm, things are in red. OK, that's my Plotting and Publishing STB. Now,

the reason for that is, that we need to start looking a little bit at plot styles, just briefly before

we end. We've got about-- what've we got? 12 minutes ish. So let's have a little look at how

that all works. He says, not going back to the PowerPoint first. Let's get-- there we go.

So, plotting and publishing from that quickly, just hover over the tab. You've got a Plot icon,

and you've got a Publish icon. So we're going to look now at the publishing, and also the color

tables and so on. So, color dependent plot styles. Hands up, who uses CTBs. Hands up, who

uses STBs? Yeah, there's a couple of you.

CTB tends to be very common because it's the default setting. So everybody goes, OK, I'm

going to use that one. Because they don't want to go any further. We're very good as humans,

we're very resistant to change. And also resistant to progress.

STBs can be very, very useful. Because they give you a named plot style in your Layer

Properties Manager. And you might just want thicker lines. You're not worried about color,

you're worried about thicker lines to demonstrate something. So that's where the STB comes

in.

And changing those plot styles, there's a little process involved. And be careful, because when

you do change from a CTB style to an STB style, there is no turning back. You cannot restore

back to CTB after you've changed it to an STB. OK, so just be aware of that one. So if I jump

into my CTB drawing there-- there we go.

Now, I have already converted to an STB drawing, and I've got it open here. So if I go into my

Home tab, and into my Layer Properties here, can you see there's my plot styles there? So

that's because I'm using an STB style there. So if I went into my Page Setup Manager in here,

like so, and I look at, let's say, A1 landscape and modify it right now. Can you see it's CTBs at

the moment? And it says that the CTB is missing, because it's gone to STBs. So the

monochrome 2 style is missing, because it's a CTB file in an STB drawing.



So that's my STB. I'm going to go back to the CTB drawing there. And what I want to do is, I

want to convert this to an STB file. So the first thing I do is, I type convert CTB, like that. And I

can then go and pick a CTB style that I want to convert to an STB style, a named plot style. So

I've already created this one here before the class, Monochrome 2.

So I click on Open. And that now converts it, can you see, to Monochrome 2 STB, which is

already there because I've tested it, and I'll save. Do I want to replace it? Yes I do. Now, the

style is now created. So that means I've created a Monochrome 2 STB file.

It does not mean, however, that I've converted the drawing yet. All I've done is created the

STB file. Now, I'll OK that. And then the next one is quite a long command, it's Convert P

Styles. So it's that one there, Convert P Styles, Convert Plot Styles. So if I click there now, it

now tells me, oh, you should convert your CTB styles. We've already done that, so we can

click on OK.

And there's my Monochrome 2 STB there. So that's the one I'm going to use to convert this

particular drawing from CTB to STB. Click on Open, and that is now converted. And the only

way you know is on the command line. It says drawing converted from color dependent to

named plot style.

There's no little dialogue box, or bubble, or anything. That's it. It's just a little line on the

command line. So it doesn't make it very obvious, which is sometimes a little bit annoying. But

this is now an STB drawing, even though I've called it CTB at the top there. And the way to

check that, again, is your Page Setup Manager.

So if I come in here and select A1 landscape again, and go to Modify, you'll see that my CTB

is missing, and everything now is STB instead. So it's Convert CTB, to convert your CTB to an

STB file. And then you run Convert P Styles. Once you've done that, though, you cannot go

back. So, that particular file there, my CTB, PlottingandPublishingCTB.dwg, should have

already saved as a different file name first.

So the way that I do this, is I have one called CTB, where I use CTBs. One called STB where

I've got STB. Otherwise, it causes a whole world of chaos, a whole world of pain. Especially as

a CAD manager, when one of your senior draftsmen says, oh, I've just converted the major

project drawing to a bunch of STB files. Did you save the CTB one? Oh, no, I didn't. No way

back. No way back at all. So just be aware that there's no way back when you do that. There's



no convert back again.

Now, how many of you configure plotters? One? Yeah, some of you. Now, again, this is one of

those ones where it's just a case of jumping into the settings. But the way that I like to do it, it's

real quick and easy. If you go to the Output tab, you can go in here, Plotter Manager. And

there's all your PC3s there.

So if I wanted to create a new one, there's a lovely [INAUDIBLE] on there, Add A Plotter

Wizard, boom. So I double click. Go through the steps, set it all up. My Computer is a network.

Plotter is a system printer. There's the manufacturer. There's the model. So I'll go with

something like, I don't know, DWFx, for example.

And now I can import any PCB or PC2 files that might exist for that particular one. Go in there,

plot to file-- well, I've got nothing to link to. So this won't go any further, unfortunately. But you

can go in there and Plot to File or Plot to a Port. And you can just configure that, and then

obviously that particular plotter is set up.

Now if you want to go in and edit individual plotter files, you can open these as well by double

clicking on them. And it'll open up the Plotter Configuration Editor. So there's the ports that it

uses, and the document settings. So you can change paper sizes and so on.

One of the jobs I worked on was a really long highways project. And we had a big long stretch

of road, and we wanted a big long drawing to plot, to go up on the wall for the public inquiry,

so the public could see what the new road was going to look like. So we had a great big A0

plotter with a big roll of paper on it. We just changed those settings to say that we wanted a

sheet that was like this long instead of a standard size. And that way we had a custom long

sheet that came off the bottom.

So you can go in there and change the plotter configurations very quickly and very easily. And

you can obviously rename them, copy them, in any which way. Obviously, don't overwrite your

existing standard settings, because then you can't remember what they were before. Always

Save As, never Save. Otherwise you'll overwrite them, and then you're done. It does-- unless

you remember what it was, you're going to have to start from scratch.

So plotting electronically. This is the bit that I wanted to get into, the DWF, the DWFx, and the

PDF. Want to take you guys through this very briefly. Won't take long. Now I'm not going to,

obviously, go in and run things like Design Review and Markup Set Manager, and so on. I'm



just going to very briefly show you how that markup can come back into a drawing.

We've also got A360. How many of you use a 360? Ah, some of you. A360 Drive is like Google

Drive, Dropbox, and so on. If you set yourself up with an AutoDesk ID, which I'm assuming all

of you have to be here, that means you've automatically got 25 gigabytes of storage space.

Go to A360.Autodesk.com, AutoDesk sign in with your AutoDesk ID. There's a whole shitload

of space there to store documents, or your Bon Jovi albums, or whatever.

And then, obviously, you've got your PDF files as well. Viewing PDF, so I'm assuming

everybody's got Acrobat Reader on their machine. Yeah? So if you want a view a PDF, double

click on it, poof, it opens up. And there's plenty of bits of software out there that allow you to

convert to PDF as well. Obviously the Adobe stuff, but there's things like PrimoPDF, Soda

PDF. They all allow you to convert your files to a PDF if need be.

So last but not least-- I'm just going to jump in here and-- the best way to work with all of your

settings and plotting, is here, In the export to DWF PDF panel, in the Outputs tab on the

ribbon. Because you can go in here and you can just say, right, I want to export to DWFx. And

you get a nice big dialogue box like that. Now this is a single DWF. So that's great, you know,

but it means I've got to do it one by one. If I've got 15 Layout tabs, that's going to be kind of

mundane, isn't it? I'm going to have to going into each one, click, save, and off we go.

So, exporting out, all of your settings are in here. So there's your Preview. You can export your

DWF options. Saying set everything up in there, all your data options and does it need a

password, and so on. And you've got your PDF options as well. If I come in here, my page

setups are there as well. So I've got a page setup there, where I can go in and edit all of my

page setups that are in my particular Layout tab at that time.

This is also an override. So I can kick in here, and if I don't like the page setup I'm using, I can

change it. I don't have to use the one I've already got. So that's exporting out. Now, if I want to

do this all in one go with all my 15 Layout tabs, I just hit Batch Plot. That's my Publish dialogue

box. There's all the different offerings that I have there, that I've got open at the moment.

These are all my different drawings by the way. So can you see that I've got a whole group of

drawings open? Platinum publishing, CTB, and STB, and that's giving me-- can you see, I've

got a model, CTB model, and STB model.

So if you only want to plot from one drawing, what you would do is, you close the drawings that

you don't actually want to plot from. So I won't save that list of sheets right now. So if I close



that, now I close that. I've only got the one drawing open. And then if I come in here like so,

and hit Batch Plot, it then just shows me-- there's the Model tab, and there's the Layout tab.

Now be very careful. Just going to close that a second. Make sure that you hit Save, before

you batch plot. Because if you go in and set all those settings in the Published dialogue box,

and you haven't saved the drawing, it will say, oh, you haven't saved the drawing. Go back

and start again. And it's great for that. It's one of those ones where you've just gone in and

you're just going to set all of this up, Ready to Plot, Number of Copies, Plot Stamp, Publishing

Background. And it goes, you haven't saved the drawing.

So always, always save the drawing before you hit the Batch Plot button. And what you've got

here-- I don't want that one to plot. I don't want to do the model. So I'm going to remove that

from the list. And I can rename these as well, which is really quite useful. Because at the

moment, all I've got is the drawing name and the tab name.

So what I might do here instead is, I might rename these. So if I rename the sheet-- instead of

having 01PlottingandPublishing, it might be that I want something like 01DWG, let's say, GA.

And then I can rename this one. And unfortunately there's no multiple way of doing this. You

do have to do them one by one.

But you can see from a consistency viewpoint, I'm renaming the sheets. I'm not renaming the

files, or the Layout tabs, of the Model tabs. This is purely in this dialog box. And it's a bit like

setting up the page setups. You've got a list a page setups you use, so you might have a

sheet list that you use to plot as well, when you're batch plotting.

So if I change this one as well, just rename it real quick. So I'm not renaming any drawings or

anything here whatsoever. And I'm just going to make that a little bit smaller there, so we can

see what we're doing. There we go. So that's-- they're all using this default A1 landscape page

setup. I can go and change the page set up for a particular drawing if I want to. And it's telling

me no errors. That's really nice. If you get errors there, it means that your page setup isn't

working for that particular tab, or Layout tab. So you can go and check it, and make sure it

works.

And last but not least, you can include a plot stamp. So, that's things like date, time, who

plotted it, and so on. And it publishes in the background. So these are all going to go-- I'm

hoping-- to my A1 landscape. So if I just select that for each one, it should, if I remember

rightly, go out to either a PDF or DWF. I can't remember which one I set it to.



rightly, go out to either a PDF or DWF. I can't remember which one I set it to.

So, I can Save. So if I save that as what they call the DSD file-- so I'll just drop that into my AU,

there we go, and Handouts, and OK. So I pop that in there, plottingandpublishing.dsd. Good

thing is, that will now remember what I've just done, the renaming of the sheets. So if I go back

into batch plotting later, I can click on Open, and go and find that DSD, and all that renaming

are just done is saved. And I can load that up ready to go. So I just hit Publish. Thinks about it.

There we go. It's processing in the background. Click on Close. And I've got a little plotter icon

chugging away there in the corner.

So when that's done, the usual little plotting bubble comes up, and you've got your batch plot

to whatever file format you're actually using at that given time. Now, obviously, you've got

those tools. Do you want to know what DWF writer is? It's actually a printer driver. So it's a bit

like printing to PDF. But the DWF writer allows you to do a Word document to a DWF, or an

Excel spreadsheet to DWF.

So it's still out there. Some of these are a little bit older now. AutoDesk haven't updated them.

Design Review is still at the 2013 version, I think. Had a conversation with some of the

AutoDesk guys yesterday about this. And it looks like Design Review might be getting a

revamp at some point, to tie-in with all the A360 stuff. So I think there's going to be some A360

functionality going in there. But don't quote me on that, OK? I don't know.

Markup Set Manager is in AutoCAD. So when you're in Design Review, you can mark things

up, send the file to somebody with AutoCAD. They can go into the Markup Set Manager and

see those design reviews that you've put in. A360 Drive is where you store all this stuff. And

obviously, viewing PDF files, if you plot it to PDF, you're going to use Acrobat Reader or

something similar.

So, Publish dialogue box. Just been through that. Again, just reviewing what we've done.

Renaming and removing the sheets. Adding plot stamps. Save the sheet list to a DSD. If

you've got about 15 layouts, and you've done all the renaming, and all the layouts, and what

page setups you're using, always save it to a DSD file. Because then you don't have to go in

and do it all over again. And publishing a sheet list, well I've just done that. I'll hope to have a

little bubble in AutoCAD pop up at some point, saying those Layouts have been plotted.

So, we're done. I've over run ever so slightly. My apologies. So, make sure you fill out your

class survey for me. If I was rubbish, please tell me. And obviously, use the AU mobile app.



You can do it online really quickly and really easily now. The app is very, very useful, I have to

say.

And obviously, the feedback is important. Not just for me, obviously, as a speaker, but

AutoDesk like that feedback as well. They like to know how AU's going, and obviously if the

classes are relevant and current and so on. And sadly, we do get our feedback in real time

now, so if I'm rubbish, I'll know in five minutes whether I was. So, it just obviously feeds back to

AutoDesk. They can then process that for next year's AU, and so on.

Now, there is a LinkedIn Learning offer here. I do a lot of work for LinkedIn, or what was

Lynda.com. There are some nice little vouchers here for 30 days of free LinkedIn Learning,

because there is a cost implication normally. So you can go and maybe check out some of my

courses. There's Revit on there, there's Inventor on there. All that kind of stuff, and it's all

expert lead training.

So please, help yourselves to that. Help yourselves to the voucher. There's a few little pens

and LinkedIn stickies there if you want them as well. So, thank you so much. And obviously,

email address is there. That's all the class handout and everything as well. So if you do want

to pop me an email or anything, please do.


